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Readiris 15 

RI_15_dgi_06102015-03 

Welcome to the Readiris documentation. The aim of this documentation is to help you get up to 
speed with using Readiris. It covers Readiris' installation and setup, the basic processing steps and 
the application's commands and working areas. At the end of the documentation you find an How to 
section in which particular questions are addressed. 
 
The procedures described in this documentation are based on the Mac OS Yosemite operating 
system. 
 
The information in this documentation is subject to change without prior notice. 

Introduction 

Readiris is I.R.I.S.' flagship document recognition software. With Readiris you can scan paper 
documents, open image files, PDF files and digital camera images and turn them into fully editable 
text documents and text-searchable PDF documents you can save, share and send to online Storage 
Systems. Readiris supports a wide range of output formats, the most important ones being PDF, 
DOCX and XLSX. 

The documents Readiris generates can either be saved on your computer, directly sent via e-mail or 
exported to online Storage Systems such as Evernote, Dropbox, Google Drive, Box and Microsoft 
OneDrive. With Readiris Corporate you can also send documents to Microsoft SharePoint. 

Readiris recognizes documents in 130 languages. All American and European languages, including 
the Central-European, Baltic and Cyrillic languages as well as Greek and Turkish are supported. 
Readiris also recognizes Hebrew, as well as four Asian languages: Japanese, Simplified and 
Traditional Chinese and Korean. 

Besides text recognition, Readiris offers powerful compression features for PDF files, thanks to 
I.R.I.S.' compression technology iHQC. 
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What's new in Readiris 15 

 Improved User Interface 

 New OCR engine 

 New Asian OCR engine 

 Multi-thread Processing 

 New Activation Procedure 

 New Output Formats: E-pub and Audio 

 New online Storage Systems: Box: OneDrive, SharePoint 

 Possibility to append PDF documents 

 Possibility to import password-protected PDF files 

 New PDF compression 

 New PDF / A-2 format 

 Easy Web viewing PDF files 

Improved User Interface 

The Readiris interface has been improved. The top toolbar now contains separate Format and 
Destination settings. 

Tip: to learn more about the new interface, see the topic Exploring the interface. 

New OCR engine 

In Readiris 15 I.R.I.S.' OCR engine DRS 15 is used, which leads to improved accuracy. 

New Asian OCR engine 

A new engine is used, which leads to better OCR results when recognizing Simplified and Traditional 
Chinese, Japanese and Korean, and language combinations with those four Asian languages. 

Multi-thread Processing 

Readiris now uses Multi-thread Processing. Thanks to Readiris' multi-thread architecture, the 
processing speed has been drastically improved.  

New Activation Procedure 

Each version of Readiris needs to be activated. The activation can be done during installation, when 
starting the application or at any other moment (from the Help menu). 

New Output Formats: E-pub and Audio 

Save your documents as E-pub to view them on an eReader. 

Save your documents in Audio to have the text read out to you.
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New online Storage Systems: Box: OneDrive, SharePoint  

The documents you process with Readiris can now be sent to Box and Microsoft OneDrive. Readiris 
Corporate also sends documents to Microsoft SharePoint. 

Possibility to append PDF documents 

In Readiris 15 you can add pages to existing PDF documents. When you save new scans to a PDF 
document that already exists, you have the possibility to append the existing document with the 
new pages. 

Possibility to import password-protected PDF files 

PDF documents of which the editing has been password-restricted can now be opened in Readiris. 
PDF documents that require a password to open them cannot be opened however. 

New PDF compression 

Additional levels of I.R.I.S.' proprietary compression technology iHQC are now available in Readiris 
Corporate. 

New PDF / A-2 output 

Readiris Corporate can now generate version 2 of the PDF / A format. PDF / A files are suited for 
long-term archiving and contain only what is strictly needed for opening and viewing them. 

Easy Web viewing PDF files 

Readiris now also generates linearized PDF files, which allow faster web viewing. This feature is 
especially convenient when you are processing documents stored on a web server. 
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Legal Notices 

Copyrights 

Copyrights © 1987-2015 I.R.I.S. All Rights Reserved. 

I.R.I.S. owns the copyrights to the Readiris software, to the online help system and to this 
publication. 

The information contained in this document is the property of I.R.I.S. Its content is subject to change 
without notice and does not represent a commitment on the part of I.R.I.S. The software described 
in this document is furnished under a license agreement which states the terms of use of this 
product. The software may be used or copied only in accordance with the terms of that agreement. 
No part of this publication may be reproduced, transmitted, stored in a retrieval system, or 
translated into another language without the prior written consent of I.R.I.S. 

This documentation uses fictitious names as examples; references to actual persons, companies or 
organizations are strictly coincidental. 

Trademarks 

The Readiris logo and Readiris are trademarks of Image Recognition Integrated Systems S.A. 
OCR and barcode technology by I.R.I.S. 
AutoFormat and Linguistic technology by I.R.I.S. 
BCR and field analysis technology by I.R.I.S. 
iHQC compression technology by I.R.I.S. 

All other products mentioned in this documentation are trademarks or registered trademarks of 
their respective owners. 

Patents 

Readiris is patent-protected. See the Release Note for more information. 

Acknowledgements 

Portions of this I.R.I.S. software uses the following copyrighted material, the use of which is hereby 
acknowledged. 

 Dropbox SDK Copyright (c) 2010 Dropbox (Evenflow, Inc.), http://getdropbox.com/ 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, 
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do 
so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

 Google APIs Client Library for Objective-C,  Copyright 2011 Google Inc., licensed under the 
Apache License, Version 2.0 (http://www.apache.org/licenses/LICENSE-2.0)  

 Live SDK for iOS, Copyright 2014 Microsoft Corporation, licensed under the Apache License, 
Version 2.0 (http://www.apache.org/licenses/LICENSE-2.0)  

http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/licenses/LICENSE-2.0
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 JSONKit, Copyright 2011 John Engelhart, licensed under the Apache License, Version 2.0 
(http://www.apache.org/licenses/LICENSE-2.0)  

Licensed under the Apache License, Version 2.0 (the 'License'); you may not use this file except in 
compliance with the License. You may obtain a copy of the License at: 

http://www.apache.org/licenses/LICENSE-2.0 

 JPEG: This software is based in part on the work of the Independent JPEG Group. 

 BWToolkit: Copyright (c) 2010, Brandon Walkin All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

 Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

 Neither the name of the Brandon Walkin nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 TIFF library: 

Copyright (c) 1988-1997 Sam Leffler 

Copyright (c) 1991-1997 Silicon Graphics, Inc. 

Permission to use, copy, modify, distribute, and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that (i) the above copyright notices and this 
permission notice appear in all copies of the software and related documentation, and (ii) the names 
of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the 
software without the specific, prior written permission of Sam Leffler and Silicon Graphics. 

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. 

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY 
OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE 
USE OR PERFORMANCE OF THIS SOFTWARE. 

http://www.apache.org/licenses/LICENSE-2.0
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Section 1: Installation and Activation 

System requirements 

This is the minimal system configuration required to use Readiris: 

 A Mac computer with a 64 bits Intel processor 

 The operating system Mac OS X 10.8 or higher. Earlier versions of the Mac OS operating 
system are not supported. 

 300 MB of free hard disk space. 

Installation and Activation 

Installation 

 Insert the Readiris CD-ROM in the CD-ROM drive of your computer. Then click the Readiris 
CD-ROM icon on the Desktop. 

 Or download the Readiris package from www.irislink.com/softwaredownload. 

 Run the Readiris installation package and follow the on-screen instructions. 

 

 Agree with the terms of the license agreement. 

 Then click Install to start the actual installation. 

You might be asked to enter an Administrator Username and Password to install 
Readiris. 

Activation 

 You are prompted to activate Readiris. 

 The activation code consists of 34 characters. Depending on how you purchased Readiris, 
the code can be found: 

o Inside the DVD box 

o On the sticker on the backside of the CD-ROM sleeve 

o On a license sheet called "License sheet for SN for IRIScan..." located inside the 
product box 

o On a separate explanatory sheet for IRIScan Book Executive 3 

o In your confirmation e-mail for electronic order 

 Enter the activation key, and then click Activate. 

Note that an internet connection is required to activate. 

You can also click Continue trial if you do not want to activate Readiris at this time. 
Next time you start Readiris you will be prompted again to activate the software. 

http://www.irislink.com/softwaredownload
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 When the installation is finished, click Close. 
The Readiris folder is added to the Applications folder by the installation program. 

Software Registration 

Registering is required to get Technical Support. It also offers other benefits, such as free updates, 
free trial downloads, video tutorials, discount on new products, and so on. 

To register Readiris: 

 On the Help menu, click Register Readiris to be directed to the Registration page. 

 

 Fill in your data and click Submit. 

Note that an internet connection is required to complete the registration.
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Check for updates 

When you register your copy of Readiris you are entitled to free software updates. 

To check if updates are available: 

 On the Help menu, click Search for Updates. 

Note: Readiris automatically checks for updates every 30 days. 

 

Uninstalling Readiris 

To remove Readiris from your computer: 

 Click Finder and open the Applications folder. 

 Drag the Readiris folder to the Trash. 

Readiris will be removed from your machine. 

Note: the Readiris preferences are not removed by dragging the Readiris folder to the trash can, in 
case you should want to re-install the software later on. 

 
To remove the preferences: 

 In the Finder's Go menu, press and hold Alt.  

 Click Library and open the Application Support folder. 

 Drag the Readiris folder to the trash. 

Technical Support 

If you register your copy of Readiris you are entitled to free technical  support. In the Technical 
Support section of our website www.irislink.com/support you can find F.A.Q.'s (frequently asked 
questions), Video Tutorials, and much more information to solve common issues. 

If you still can't find an answer to your question, click Technical Support Contact and fill in the Web 
Contact Form. 

http://www.irislink.com/support
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Section 2: Getting Started 

Exploring the interface 

The new Readiris interface looks as follows: 

 

The interface consists of the following components and panels: 

1. The Readiris menu bar 

The Readiris menu bar regroups all the commands and options available in Readiris, including 
advanced settings. 

2. The top toolbar 

The top toolbar is by far the most important tool in Readiris. It contains all the basic commands you 
need to process your documents. The commands are classified per group. 

The top toolbar can be customized in two ways: 

 You can add or remove output formats in the Format group and add or remove destinations 
from the Destination group by clicking the down arrows. 

 

 You can add or remove commands from the toolbar: Ctrl-click the toolbar, click Customize 
Toolbar and drag-and-drop the commands you want to move from or to the toolbar. 
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3. The Scanned image 

When a document is scanned or opened into Readiris, its image is displayed. The different 
recognition zones are displayed. The zones can be edited with the tools in the Image and Layout 
Editing panel. 

4. The Pages panel 

Each page you scan or open in Readiris has its thumbnail displayed in the Pages panel. The pages are 
processed top-down. To change the order of the pages, you drag a page from one location to 
another. 

To have a better overview of the page thumbnails you can switch to Thumbnail view. In this view 
only the page thumbnails are displayed. The analyzed image is not displayed anymore. In Thumbnail 
view the thumbnails run from left to right, and from top to bottom. 

To switch to Thumbnail view, click the Thumbnail view icon at the bottom of the Pages panel. 

 

5. The Image and Layout Editing panel 

The Image Editing panel allows to modify the current page: you can deskew pages that were 
scanned at an angle, rotate them, adjust the image quality, and so on. Point to the different buttons 
to display their tooltips. 

Also see the sections Optimizing the Scanned Documents and Editing the Recognition Zones for 
more information. 

Changing the user interface language 

Readiris opens in the user interface language that is currently activated in your Mac System 
Preferences. 

To change the user interface language in Readiris: 

 Click the System Preferences icon. 

 

 Click the Language & Region icon. 

 

 Drag the language of your choice to the top of the list. 

The user interface of Readiris is available in a wide range of languages. 

 Close Readiris and restart the computer to apply the new language settings.
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Configuring your scanner in Readiris 

Readiris supports all Twain 1.9 compliant scanners, all Image Capture compliant scanners, and 
IRIScan 2 and higher scanners. 

Most Image Capture scanners are plug and play. Before you can use a Twain scanner, however, its 
drivers need to be installed on your Mac. 

Twain scanners 

 Connect your scanner to your Mac and power it on. 

 Install your scanner's Twain driver. 

In general, drivers can be found on the CD-ROM provided with your scanner and on the 
website of your scanner manufacturer. They are not provided by I.R.I.S. Note that some 
scanner drivers may not work under the latest versions of Mac OS. See the 
documentation supplied with your scanner to find out which platforms are supported. 
If necessary, contact your scanner manufacturer. 

IRIScan Express scanners 

 Connect your IRIScan Express scanner to your Mac and power it on. 

 If Readiris is part of your IRIScan product, the driver has been installed during the installation 
of Readiris. 

If that is not the case, visit our website www.irislink.com/support to download and install the 
required driver. 

IRISCard Anywhere / IRIScan Anywhere / IRIScan Book scanners 

You do not need to install any drivers when using these scanners. They are not Twain driver-based 
scanners that can be used from within any application to scan documents. Instead, they are 
designed to be used on their own, disconnected from any computer. The documents you scan are 
stored in the scanner’s internal memory (or optional SD card / USB flash drive). From there, they can 
be loaded directly into Readiris when you connect the scanner or insert the SD card or USB flash 
drive into your Mac. 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.irislink.com/support
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To check if the scanner driver has been installed successfully: 

 In the Readiris menu, click Preferences. 

 Click the Scanner tab. 

 You should see your scanner listed*. 

*This is not the case for the IRISCard Anywhere, IRIScan Anywhere and IRIScan Book 
scanners. 

 

If your scanner is not listed, its driver has not been installed successfully. 

Note that the IRIScan settings at the bottom are only available if an IRIScan Express 2 
scanner is connected. Later versions of IRIScan Express function as regular Twain 
drivers. 

 Once the scanner has been configured you can start scanning, using the default scanner 
settings. 
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Section 3: Basic Document Processing 

Processing documents with Readiris is fairly straightforward when using a basic configuration. In this 
section we discuss which steps to take when doing such a basic configuration. For detailed 
information about all the configuration steps, see sections 4 to 10. 

Step 1: Scan or Open your images 

In order to scan paper documents your scanner must be correctly configured. See the section 
Configuring your scanner if necessary. 

 Click Scan to scan paper documents with your scanner. 

A preview window opens and displays your scanner settings. With TWAIN scanners, these 
settings differ from one scanner to another. 

 Select Color and 300 DPI as preferences to obtain optimal results. 

 Select the Page Analysis Options of your choice: 

Page Analysis is selected by default. This option divides your documents into 
recognition zones. Without recognition zones, Readiris cannot process your 
documents. If you choose to disable this function, you will need to draw recognition 
zones manually on your documents. 

Readiris can deskew (straighten) documents and rotate them by means of Page 
orientation detection. 

When your scanner generates black borders around your documents, or when your 
documents contain information that is partially cut from the page, Readiris tends to 
create recognition zones on the borders of the document, even though they do not 
contain any useful content. In such cases it is recommended to use the option 
Ignore border zones. 

 

or 

 Click File to open existing image files. 

 Select the Page Analysis Options of your choice. 

The same Page Analysis Options are available here. 
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The images are displayed in the interface. 

 

Step 2: Modifying the images 

The images you scan and load into Readiris can be modified easily: 

 To change the order of the pages, drag the thumbnails to a different position in the Pages 
panel. 

 To delete a page, select a page and click the delete icon. 

 To delete a zone, select it and press the Backspace button on your keyboard. 

If necessary you can modify the recognition zones. See the section Editing the Recognition Zones for 
detailed information. 

Step 3: Select the Recognition Language 

Selecting the right document language is essential to obtain good recognition results with Readiris. 
The default language is set to the current language of your operating system. 
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Step 4: Select the Output format 

 In the Format group, click the output format you want to generate. 

You can, for instance, save your documents as DOCX documents to do text editing, or save 
them as PDF documents for storage purposes.  

 If the format of your choice is not listed: 

 Click the down arrow.  

 Select the format of your choice and drag it to the Favorites list.  

 Configure its formatting options. 
For detailed information about the different output formats and the different 
formatting options, see the sections Saving Documents and Selecting the Layout 
Options. 

 Click OK to close the settings. 

 Now select the format you configured in the Format list. 

Step 5: Select the Destination 

 In the Destination group, select where you want to send your documents: you can save 
documents locally or in a configured online Storage System. 

Note that the connection to the online Storage System must be configured correctly to be 
able to export. See the section Saving Documents to online Storage Systems to learn how to 
do so 

 Click the down arrow, and then select the destination of your choice. 

 

 When you select Save locally, a default application is suggested for the selected output 
format.  
When you select PDF for instance, the output file will be opened in the Preview application. 
DOCX and RTF documents will be opened in the installed text editing applications. XLSX 
documents will be opened in the installed worksheet editor. 

 To change the application, click it and then click Select Application. 

 

When you've gone through these steps, click Save to start the text recognition and generate output 
documents. 
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Starting a new project 

When you are done saving your scanned documents, or when you want to start over: 

 Click New on the top toolbar. 

This command erases your documents from Readiris so you can start a new project. 

 

Automatic Processing 

If you want to speed up the processing in Readiris or need to process batches of scanned 
documents, you can use the Automatic Processing feature. This feature automatically processes the 
documents you scan and open in Readiris, converts them into the output format you defined, and 
exports them either to a specific folder you defined or to the configured Storage System. 

To start automatic processing: 

 First, determine all the settings you want Readiris to apply. See the section Basic Document 
Processing if necessary. 

 On the Process menu, click Automatic Processing. 

 Select Automatically process all imported images, and select an Output folder to which the 
processed documents are exported. 

 

 Then start scanning or opening documents in Readiris. Or drag series of image files to the 
Readiris icon. 

Important notes: 

When you scan multiple documents one after the other - on a scanner equipped with a 
document feeder for instance - all the documents are bundled into a single output file. The 
same goes for opening multiple image files at a time. 

When you scan documents on a flatbed scanner, each page will be saved in a separate 
output file. 

Notes: 

You can also export documents to your online Storage Systems Google Drive, Evernote and 
Dropbox. In that case any Output folder you selected is ignored. 
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Tip: 

To add the Automatic Processing feature to the top toolbar: 

 Ctrl-click inside the top toolbar, and select Customize Toolbar. 

 Then drag the Automatic Processing icon to the toolbar and click Done. 

Tip: 

Besides Automatic Processing, Readiris Corporate also offers Batch Processing and Watched 
Folder features to process larger batches. 

Saving and loading settings 

Note that Readiris saves the processing settings automatically when closing the application. Next 
time you start Readiris it applies the same settings. 

In case you want to save a specific settings profile: 

 First, select the required settings. 

 On the Settings menu, click Save Settings. 

 Name the settings, select an location and click Save. 

Note: if you want to save specific settings as default settings, click Save as Default on the Settings 
menu. 

 

The following settings will be saved: primary and secondary languages, favor recognition accuracy 
over speed, font type, character pitch, output format and any selected output format options, 
including PDF passwords, target application, online storage system settings, page sizes, page 
separation and indexing settings, user lexicon options, page analysis, despeckling and deskewing 
options and training options. 

Google Drive account passwords are saved securely in the Mac OS KeyChain password container.
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Loading Settings 

To load a settings file you saved: 

 On the Settings menu, click Open Settings. 

 Browse for the settings file you saved. 

Restoring Factory Settings 

 On the Settings menu, click Restore Factory Settings. 
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Section 4: Scanning and Opening Documents 

General Processing Options 

When scanning and opening documents, Readiris applies several general processing options. 

To access these options: 

 On the Readiris menu, click Preferences. 

 The Preferences window opens on the General tab. 

 

The options you set here are applied as default to all the documents you'll open or scan. 

Preprocessing Options. 

Smoothen color and grayscale images 

This option is activated by default. It renders grayscale and color images more homogeneous by 
smoothening out differences in intensity. As a result, a stronger contrast is created between the 
foreground (text) and background (artwork). Sometimes smoothening is the only way to separate 
text from a colored background. 

Process as 300 dpi 

Select the option Process as 300 dpi when you are processing images of an incorrect or unknown 
resolution. The images will be processed as if they had a 300 dpi resolution.
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Automatic despeckling 

Sometimes documents contain a lot of "noise" - little black spots that occur when scanning low-
quality documents or using bad scanner settings. 

To remove these little black spots, use the Despeckle slider. The more you move it to the right, the 
larger the spots that will be removed. 

Page Analysis Options 

Note that you can also access these options via the Settings menu. 

Page Analysis 

Page Analysis is selected by default. This option divides your documents into recognition zones. 
Without recognition zones, Readiris cannot process your documents. If you choose to disable this 
function, you will need to draw recognition zones manually on your documents. 

Page Orientation Detection 

This option detects in which direction your documents are oriented and rotates them automatically. 

 

Page Deskewing 

This option staightens - or deskews - pages that were scanned at an angle. 

 

Ignore Border Zones 

When your scanner generates black borders around your documents, or when your documents 
contain information that is partially cut from the page, Readiris tends to create recognition zones on 
the borders of the document, even though they do not contain any useful content. In such cases it is 
recommended to use the option Ignore Border Zones. 

  

When you are done, close the Preferences window. The settings are saved automatically.
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Scanning Documents 

Readiris is Image Capture and Twain compliant. It supports almost any flatbed and sheet-fed 
scanner, all-in-one device, digital camera and scanner currently available. 

Before you begin: make sure your scanner is connected to your computer and configured correctly. 
To do so, go to the Readiris menu and click Preferences. If you see your scanner listed on the 
Scanner tab it is correctly installed. If you don't see it, refer to the topic Configuring your scanner. 

To scan documents: 

 Click Scan. 

 A preview window opens, displaying the settings available for your scanner. 

Note that with TWAIN scanners these settings differ from one scanner to another. 

 Select Color and 300 DPI as preferences to obtain optimal results. 

When you are scanning business cards or Asian languages it is recommended to use a 
scanning resolution of 400 dpi. 

 

 Then select the Page Analysis options 

See General Processing Options for more information. 

 Click the Scan button in the dialog box to start scanning documents. 

Note: pay attention to line skew. Line skew over 0.5° increases the risk of OCR errors. 

Tips: 

 Sometimes Twain scanners display white text on a black background when scanning in black-
and-white. To avoid this, click Preferences on the Readiris menu. Then click the Scanner tab 
and select Invert Black & White images from TWAIN scanners. 

 To scan batches of documents, see the sections Automatic Processing and Watched Folder. 

 Readiris can be set as target application of your scanner, if your scanner supports that 
feature. That way you scan documents on your scanner and transfer them to Readiris, just 
by clicking your scanner buttons. See your scanner documentation for more information.
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Scanning with I.R.I.S. scanners 

IRIScan Express 2 

When using an IRIScan 2 scanner there are specific settings you can apply. 

 On the Readiris menu, click Preferences. 

 Click the Scanner tab. 

 

Format 

You can either choose an automatic scanning format or a custom format for which you can 
indicate the page height and width. 

Depth 

Readiris supports black-and-white, grayscale and color images. 

Resolution 

Select a scanning resolution of 300 dpi. 

When you are scanning business cards or Asian languages it is recommended to use a 
scanning resolution of 400 dpi. 

Calibrate 

Click the Calibrate button should it be necessary to calibrate your scanner. 

 When you are done, close the Preferences windows and start scanning documents.
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IRISCard / IRIScan Anywhere / IRIScan Book 

Preliminary note 

The IRISCard and IRIScan Anywhere, and IRIScan Book scanners are designed to be used on their 
own, disconnected from any computer. The documents you scan are stored in the scanner’s internal 
memory (or optional SD card / USB flash drive). 

From there they can be loaded into Readiris. 

So, note that these scanners are not Twain-driver scanners that can be used from within any 
application to scan documents. Instead, think of them as USB storage devices that are able to scan 
independently. 

To load scanned documents into Readiris: 

 Connect your scanner to your computer with the provided USB cable and power it on. 

 OR insert the SD card or USB flash drive you used in the scanner into your Mac. 

 Readiris detects if card images were scanned to the storage medium. Click Yes to select 
them. Readiris then opens the right folder. 

 

Opening Image Files 

Besides scanning documents, you can also open image files and PDF files with Readiris. 

Readiris supports the following image file formats: GIF images, JPEG images, JPEG2000 images, 
Photoshop images, PNG images, (uncompressed, packbits and Group 3 compressed) TIFF images, 
multipage TIFF images, Windows bitmaps (BMP) and PDF documents. 

To open existing image files: 

 Click the File button. 

 

 Then select the images files you want to process, and click Open. 
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You can also open multiple images files at a time: 

 Select the first image file and hold down the Cmd-key as you select additional images or; 

 Select a continuous range of image files by clicking the first image and holding down the 
Shift key as you select the last image. 

Should you want to abort the loading process, click the x icon in the top right corner of the progress 
bar. 

Tip: when loading multipage image files (TIFF images) and PDF documents, you can define the page 
range (in case you only need a certain chapter of a document for instance). 

Note: when you click the File button on the top toolbar after you saved your current document, you 
are prompted whether you want to delete the current document. Click No to add image files to the 
recognized document or click Yes to start a new document. 

Other ways of opening image files 

 Drag image files to the Readiris icon to open them. 

 Ctrl-click any image file you want to open, point to Open With and click Readiris. The 
Readiris software will open and display the image. 

 Readiris can be set as target application of your scanner, if your scanner supports that 
feature. That way you scan documents on your scanner and transfer them to Readiris, just 
by clicking your scanner buttons. See your scanner documentation for more information. 

Tip: to process batches of images files, see the topics Automatic Processing and Batch Processing. 

Opening Digital Camera Images 

Readiris automatically detects when images have been made by a digital camera and uses special 
recognition algorithms to process them. 

To open digital camera images: 

 Click File on the top toolbar. 

 

 Select your digital camera images and click Open. 

 In the page thumbnail, you see a little camera icon, which indicates Readiris recognizes the 
image as digital camera image. 
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If Readiris does not detect your image is a digital camera image: 

 Ctrl-click the page thumbnail. 

 Select Digital Camera Image. 

 

Deskewing Digital Camera Images 

When photographing documents with a digital camera, it may happen that the documents are shot 
from an angle, which gives them a 3D effect and renders the recognition impossible. 

To solve this issue, you can deskew your digital camera images: 

 Open your digital camera image. 

 On the Layout and Editing toolbar, click the Deskew icon. 

 

 Drag the corners one by one in the direction of your text. 

 

 Click Apply to deskew the image. 
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Tips for making digital camera images 

 Always select the highest image resolution. 

 Enable the macro mode of the camera to take close-ups. 

 Enable the document mode of the camera (if any). 

 Only use optical zoom, not digital zoom. 

 Hold the camera directly above the document. Avoid photographing documents at an angle. 

 Produce stable images. 

 Disable the flash when photographing glossy paper. 

 Avoid opening compressed camera images. 
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Section 5: Selecting the Recognition Options 

Readiris converts scanned images, image files and PDF files into editable text documents and text-
searchable PDF documents. In order for Readiris to recognize the text in your images, you need to 
select the correct recognition options. 

By far the most important recognition option is the document language. 

To select the document language: 

 Click the language list, and select your document language. 

When you are using Readiris for the first time, a list of 10 languages is displayed. This list 
corresponds to the preferred languages list of your Mac Operating System. 
Afterwards, the 10 languages most frequently used in Readiris will be displayed. 

 To access the complete list of available languages, click Other Languages. 

 

Tip Readiris Pro: in case you want to recognize documents in multiple languages, make sure 
to select the language with the largest character set. E.g. if you want to recognize a document 
that contains both English and French text, select French as document language. This way, the 
accents will be recognized correctly. 

Other Recognition Options 

Recognizing Numeric Documents 

When you are processing documents that only contain numbers and almost or no text, then it is 
recommended to select the Numeric option: 

 Click the language list and select Other Languages. 

 Then select Numeric at the top of the list. 

 

When this option is selected Readiris only recognizes the numerals 0-9 and the following series of 
symbols: 
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+ 

plus 

sign 

* 

asterisk 

/ 

slash 

% 

percentage 

sign 

, 

comma 

. 

period 

( 

opening 

parenthesis 

) 

closing 

parenthesis 

- 

hyphen 

= 

equation 

sign 

$ 

dollar 

sign 

£ 

pound sign 

€ 

euro sign 

¥ 

yen sign 

  

Recognizing Western words in non-Latin alphabets 

When you are processing Cyrillic, Slavic, Greek or Asian documents that also contain "Western" 
words written in the Latin alphabet - such as proper nouns, then it is recommended to select one of 
the available Language pairs. 

Language pairs are always combined with the English language and are available for Russian, 
Byelorussian, Ukrainian, Serbian, Macedonian, Bulgarian and Greek. 

Note: when processing Asian or Hebrew documents, mixed characters sets are used automatically. 

To select a Language pair: 

 Click the language list > Other languages. 

 Select the required language pair in the (primary) language list. 

 

Selecting the language per page 

When specific pages use a different language than the overall document, you don't need to define a 
secondary language. You can apply a different language to those pages. 

Select the pages in the Pages panel, Ctrl-click them and use the command Language to assign 
another language than the overall document language to that/those page(s). 

 

Pages with a different language than the overall language are marked in red in the Pages panel. 
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Unlike secondary languages, there are no limitations here. 

Note: the tooltip of each page in the Pages panel indicates which language applies to that page. 

  

Recognizing Secondary Languages inside a single document (Readiris Corporate 
only) 

When your documents contain text in multiple languages, it is recommended to select a main 
recognition language, combined with several Secondary languages. You may select up to 4 
secondary languages: 

 Click the language list. 

 Select the Primary language. 

 Cmd-click to select the Secondary languages. 

The list of secondary languages changes depending on the selected primary languages. 

Note: do not select languages that do not apply; the bigger the character set, the slower the 
recognition and the higher the risk of OCR errors. 
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Advanced Text Recognition Options 

Next to the document language you can also configure Advanced Text Recognition Options in 
Readiris. You can modify the document characteristics Font type and Character pitch, which play an 
important role in the recognition process, favor recognition accuracy over speed or vice versa and 
use User Lexicons to assist the recognition. 

To access the Advanced Text Recognition Options, click Settings > Advanced Text Recognition 
Options. 

 

Font type 

Readiris distinguishes between "regular" and dot matrix printed documents. Dot matrix symbols (of 
the type 9 pin) are made up of isolated, separate dots. 

Special segmentation and recognition techniques are required to recognize dot matrix documents 
and need to be activated. 

 

 The font type is set to Automatic by default. 

That way, Readiris recognizes "25 pin" or "NLQ" (Near Letter Quality) dot matrix, or other 
"normal" printing. 

 To recognize only dot matrix printed documents, click Dot matrix. 

Readiris will recognize so-called "draft" or "9 pin" dot matrix printed documents. 

Character Pitch 

The character pitch is the number of characters per inch in a typeface. The character pitch can either 
be fixed, in which case all characters have the same width, or proportional, in which case the 
characters have a different width. 

 The character pitch is set to Automatic by default. 

 Click Fixed if all characters of the typeface have the same width. This is often the case in old 
typewriter documents. 

 Click Proportional if the characters of the typeface have a different width. Virtually all fonts 
in newspapers, magazines and books are proportional. 
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Note: the Font type and Character pitch settings do not apply when processing Asian or Hebrew 
documents. 

User Lexicons (Readiris Corporate only) 

During recognition, Readiris is assisted by linguistic databases to recognize text correctly. These 
linguistic databases are standard lexicons and are available for every supported language. 

As powerful as these standard lexicons may be, the recognition accuracy can still be boosted using 
customized user lexicons. By means of user lexicons, Readiris can recognize technical, scientific, legal 
and company-specific terminology it would otherwise have difficulty with. 

See the section Using User Lexicons for more information. 

Speed vs. Accuracy 

In Readiris you can choose whether to favor recognition speed over accuracy and the other way 
around. 

Tip: when you are processing low-quality images, it is recommended to set this feature to 
accuracy. This yields markedly better results. 

To access the Speed vs. Accuracy option: 

 Click the Settings > Advanced Text Recognition Options. 

 Click the Accuracy list and then select the required option. 
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Using user lexicons 

(This section applies to Readiris Corporate only) 

During recognition, Readiris is assisted by linguistic databases to recognize text correctly. These 
linguistic databases are standard lexicons and are available for every supported language. 

As powerful as these standard lexicons may be, the recognition accuracy can still be boosted using 
customized user lexicons. By means of user lexicons, Readiris can recognize technical, scientific, legal 
and company-specific terminology it would otherwise have difficulty with. 

To create and use a user lexicon: 

 On the Settings menu, click Advanced Text Recognition Options. 

 Click User Lexicon Editor. 

You can also access the User Lexicon Editor in the Readiris installation folder. 

 On the File menu click New to open a new lexicon. 

 

 Insert the words you want Readiris to recognize and click the Add button. 

You can also copy-paste text segments from other files and import and edit existing text 
files. 

Tip: importing company documents or word lists may be the fastest way to create a user 
lexicon containing company-specific terminology. 

The terms you enter are sorted alphabetically. 

Duplicate words are removed automatically. 

 Click Save to save the lexicon file in the folder of your choice. 

 Return to the Advanced Text Recognition Options in Readiris. 

 Click Lexicon > Select lexicon file. 

 Select the user lexicon file of your choice in the dialog box. 

Note that in order for Readiris to recognize the words in the user lexicon, the correct 
language must have been selected. Also note that words containing characters that do not 
exist in the selected language will not be recognized correctly. 

 Click OK to close the settings. 

 Then process your documents to start the recognition. 

Syntax rules 

Several syntax rules apply when inserting terminology: 

 Case differences are maintained. 

E.g. IRISCard stays IRISCard 

 All punctuation symbols and special characters at the beginning and end of words are 
filtered out automatically. 

 Hyphens inside words are maintained. 
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E.g. Notre-Dame-de-Paris stays Notre-Dame-de-Paris 

Tip: watch out for hyphenation at the end of a line when you import text files or copy-paste 
words that cover two lines. 

 Numbers are rejected. Digits, however, can occur inside product names and are included. 

E.g. FAT32 stays FAT32. Systolic 150 will become Systolic 

Training Mode 

(This feature is not available for Asian languages) 

To improve the recognition results, you can use Readiris' Training Mode. By means of training you 
can train the recognition system on fonts and character shapes, and correct the OCR results if 
necessary. During the training process, any characters the recognition system isn't sure of are 
displayed in a preview window, in combination with the word in which they were spotted and the 
result suggested by Readiris. 

 

1 A character Readiris isn't sure of. 

2 The word in which the character was spotted. 

3 The solution how Readiris suggests to recognize it. 

Training can substantially enhance the accuracy of the recognition system and is particularly useful 
when recognizing distorted, defaced forms. Training can also be used to train Readiris on special 
symbols it is unable to recognize initially, such as mathematical and scientific symbols and dingbats. 

ATTENTION: training occurs during recognition. The training results are temporarily stored in the 
computer memory, for the duration of the recognition. Readiris will no longer display the trained 
characters when OCRing the rest of the document. When a new document is OCRed, the training 
results are erased. To save training results permanently, use the Training Mode in combination with 
a font dictionary. 

To enable Training mode: 

 Click the Training menu. 

 Select Training Mode. 
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Using Font Dictionaries 

As stated above, it is recommended to use the Training Mode combined with a Font Dictionary, in 
order to store the training results permanently. 

To create a new Dictionary: 

 Enable Training mode as explained above. 

 Click Training > New Dictionary. 

 Process your document, go through Training Mode (explained below) and Save your 
document. 

 Click Training again and now select Save Dictionary. 

 Name the Dictionary and save it in a location of your choice. 

Note: Font Dictionaries are limited to 500 shapes. You are recommended to create 
separate dictionaries for specific applications. 

To open an existing Dictionary: 

 Click Training. 

 Click Open Dictionary. 

 Browse for your Dictionary file and click Open. 

Using Training Mode 

 Enable Training mode as explained above. 

 Scan or Open your document and click Save. 

 At the end of the recognition, Readiris enters the Training Mode. 
The characters the recognition system isn't sure of are displayed. 

 

If the results are correct: 

 Click the Learn button to save the result as sure. 
If you are not using a Font Dictionary, the training results are temporarily 
stored in the computer memory, for the duration of the recognition. When 
you scan a new document, you will have to go through the same steps again.  
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If you are using the New Font Dictionary option and Save the Dictionary 
afterwards, you won't have to go through the same steps again. 

 Click Finish to accept all solutions the software offers. 

If the results are incorrect: 

 Type in the correct characters and click the Learn button. 
Note: if you are dealing with documents that contain special characters that 
are not available on your keyboard, click the browse button to open the 
Character Palette. Double-click the character you want to insert. 
You can also drag and drop a character from the Character Palette to the 
character field in Training Mode.  

 

or 

 Click Don't learn to save the result as unsure. 
Use this command for damaged characters which could be confused with 
other characters if trained. E.g. the number 1 and the letter I, which have an 
identical form in many fonts. 

 Click Delete to delete characters from the output. 
Use this button to prevent document noise from appearing in the output 
file. 

 Click Undo to correct mistakes. 
Readiris keeps track of the last 32 operations. 

 Click Abort to abort Training mode. 
All training results will be deleted. Next time you click Save, Training Mode 
will start again. 
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Section 6: Optimizing the Scanned Documents 

The documents you scan and open in Readiris can be optimized in several ways with the Image and 
Layout Edting toolbar on the right side of the interface. 

Deskewing pages 

When a page has been scanned crookedly it can be deskewed - or straightened. 

To deskew a page: select the page, then click the Deskew icon. 

 

 

Deskewing digital camera images 

Readiris automatically detects if an image was made by a digital camera. 

Notice the camera icon on the page thumbnail. 

 

If the image was made from an angle, you can correct its perspective with the Deskew icon. 

Notice that the Deskew icon looks different for digital camera images. 

 

To deskew an image: 

 Select the image, then click the Deskew icon. 

 Drag the corners one by one in the direction of your text. 

Make sure the top and bottom sides are parallel to the text. 

Make sure the right and left sides are parallel to the text margins. 
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 Click Apply to deskew the image. 

Rotating images 

To rotate an image, click the Rotate icon. Then click the required option. 

 

Adjusting the Image Quality 

The recognition results depend a great deal on the image quality of your documents. If you're 
scanning very low-quality documents, Readiris will not be able to recognize them properly. 

The reason for this is that Readiris works by converting pictures of text characters into actual text 
characters. If your documents are too dark, the characters fade into one another and create black 
spots. If your documents are too light, the text characters might be broken. Consequently, Readiris 
will not be able to recognize them. 

Example 1: text is too dark 

Here, the letter shapes begin to fill in and become fuzzy. Letters like a, e, and o are almost 
completely blurred. 

 

Example 2: text is too bright 

Here, the text characters start to show gaps and incomplete shapes. 
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To improve the recognition results: 

 Check the Scanner Settings and make sure your documents have been scanned in a 
resolution of 300 dpi and in color. 

 If that's not the case, re-scan your documents using these settings. 

Then access the Image Adjustment options: 

 Click the Adjust icon on the Image and Layout Editing toolbar. 

 

Smoothen (color or grayscale) image 

This option is selected by default. It smoothens out differences in intensity, creating a greater 
contrast between the text and the background. Sometimes smoothening is the only way to separate 
text from a colored background. 

Brightness 

Move the slider to increase or decrease the brightness of your documents. 

Example 1: image is too dark 

The image below is too dark and results in a plain black image. There is no text to be recognized. 

   

In this case you need to brighten the image in order for the text to be displayed. 

 

Example 2: image is too bright 

The image below is too light and results in broken text characters. The text is hardy legible. 

   

In this case you need to darken the image to obtain satisfactory results. 

 

 

 

 

 



Readiris 15 - User Guide 

42 

Contrast 

Move the slider to increase or decrease the contrast between the text and the background. 

Example 

The image below results in broken text characters. 

 

In this case you need to increase the contrast to obtain satisfactory results. 

 

Despeckle 

Sometimes documents contain a lot of "noise" - little black spots that occur when scanning low-
quality documents or using bad scanner settings. 

To remove these little black spots, use the Despeckle slider. The more you move it to the right, the 
larger the spots that will be removed. 

  

When you are done adjusting the image quality: 

 Click Apply to preview the results. 

 If the results are satisfactory, click OK. If not, change the settings again. 

Important note: the Image Adjustment options are applied the binarized image only. Once you have 
applied them, the original image is displayed again. 
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Section 7: Editing the Recognition Zones 

Introduction 

When you scan a document or open an image file in Readiris, each page is divided automatically into 
recognition zones. Readiris uses these zones to determine how each part of your documents must 
be converted. If your document does not contain any zones, no recognition will be done. 

In Readiris there are 4 kinds of recognition zones. You have text zones, image zones, table zones and 
barcode zones. 

Notice that each zone type has its own color. 

Text zones Orange 

Image zones Blue 

Table zones Purple 

Barcode zones Green 

The zones are also numbered; notice the number in the top left corner of each zone. The numbers 
run top-down and from left to right. They indicate the order in which the zones are recognized. 

Viewing the Recognition Zones 

Several viewing options are available allowing you to inspect the opened images and their 
recognition zones. 

Changing the View Size 

 Click the Size icons in the bottom right corner of the interface. 

 

 Then select the required option. 

Note that you can also use keyboard shortcuts to apply these viewing options. 

Zooming in on images 

 Click the Loupe icon on the Image and Layout Editing toolbar. 

 

 Then move the Loupe over the image. 

You can also use the keyboard to zoom in on images: 

 Shift-click on an image to zoom in. 

 Then Alt-click on the image to grab it and move to another section of the image. 
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Modifying the automatic Page Analysis 

Readiris divides documents into text, table and graphic recognition zones when the option Page 
Analysis has been activated. This automatic page analysis can be modified in several ways. For 
instance, you can expand and reduce zones in size, move zones to a different location, manually 
create new zones, change the zone type of existing zones, change the sort order, and so on. 

Note, however, that is not possible to do any text editing inside Readiris. That sort of editing is to be 
done after you sent your documents to a target application. With Readiris you can for instance send 
your documents to word processors such as TextEdit, Microsoft Word, Pages, and so on. 

Expanding or reducing zones 

 Click inside a zone. 

Notice the markers on the sides and in the corners of the zone. 

 Click on a marker, hold the mouse button and drag the frame to the required size. 

Moving zones 

 Click inside a zone you want to move. 
The entire zone is now marked in its corresponding color. 

 Hold the mouse button, and drag the frame to the position of your choice. 

Deleting zones 

 Click the zone you want to delete. 

 Or Cmd-click to select multiple zones. 

The entire zone(s) are now marked in their corresponding color. 

 Then press the Backspace button on your keyboard. 

Deleting all zones 

 On the Edit menu, click Delete All Zones. 

Deleting small zones 

 On the Edit menu, click Delete Small Zones. 

All zones that are smaller than 50 pixels will be removed. 

Manually drawing zones 

 Click the Layout icon to display the Layout tool. 

 

 Click the zone type you want to create. E.g. Text. 

 On the right side of the tool, set the option to Click and drag to draw new Text zones. 
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 Then click and hold the mouse button and draw a frame around the section to want to 
recognize as text. 

Note that barcode zones must always be drawn manually. They are not created automatically 
by the Page Analysis feature. 

Changing the zone type 

 Click the Layout icon to display the Layout tool. 

 Click the zone type you want to create. 

 On the right side of the tool, set the option to Click on existing zones to set as .... 

 

 Then click the zones you want to change. 

Changing the sort order of zones 

 Click the Layout icon to display the Layout tool. 

 Click the Sort icon. 

The numbers now disappear from the zones. 

 Now click the recognition zones one by one, in the order you want to sort them in. 

Zones you do not click, will be excluded from recognition. 

 Then click OK to save the new sort order, or click Cancel to keep the original sort order. 

Connecting zones 

Suppose you have two text zones that belong together, and you want to turn them into one single 
text zone. In that case: 

 Click the Layout icon to display the Layout tool. 

 Click the Text icon. 

 Then draw a text zone that overlaps the two zones to connect them. 

 

 

 

 The two zones are merged into one. 
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Note that only zones of the same zone type can be connected. 

OR 

 Close the Layout tool. 

 Click a zone to select it. The entire zone is now marked in its corresponding color and the 
markers on the borders are displayed. 

 Click one of the markers and expand a side of the zone until it overlaps with another zone of 
the same type. 

 

 The two zones are merged into one. 

Recognizing a particular area 

In case your document only contains content in a certain area of the page, you can use the Frame 
option to exclude the remainder of the page from the recognition. 

 Click the Layout icon to display the Layout tool. 

 Click the Frame icon. 

 Then draw a frame around the section that contains the information. 

Everything outside the frame will be ignored. 

You will also be prompted whether you want to ignore the same area on all the pages of the 
current document. 

Note: the command Frame Area to Analyze on the Layout menu carries out the same 
operation. 

 

Re-doing the Page Analysis 

If you are not satisfied with the changes you made, note that you can always redo the automatic 
page analysis. 

 Click the Analyze icon to do so. 
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Using zoning templates 

When you want to scan many similar looking documents, it might be useful to apply zoning 
templates, instead of editing the recognition zones each time. In a zoning template you indicate 
what your documents look like and where the text, picture or tables zones are located. This way, 
Readiris only looks in the indicated areas, saving you a considerable amount of time. 

To create a zoning template: 

 Scan the first document. 

 Edit the zones to your liking. 

See Editing the Recognition Zones for more information. 

 On the Layout menu, click Save Layout. 

 

To use a zoning template: 

 First, deactivate Page Analysis on the Readiris menu > Preferences > General. 

 

 On the Layout menu, click Open Layout. 

 Then, scan or open your documents in Readiris. 

 The same layout is applied to all the documents you open. 

To stop using the template, re-activate Page Analysis again. 
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Manually copying the zoning layout. 

It is also possible to manually copy the zoning layout from one page to another: 

 Cmd-click the zones you want to copy to another page. 

Tip: make sure the Layout tool is closed. Otherwise, Cmd-click won't work. 

 Then press Cmd+C on the keyboard. 

 Go to the page to which you want to copy the zoning layout. 

 Click inside the image  and press Cmd+V on the keyboard. 
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Section 8: Selecting the Output Format 

The documents you process with Readiris can be saved in a large number of output formats, ranging 
from plain text files to fully formatted Word processing and Spreadsheet files, and PDF files. With 
Readiris you can also turn Image PDFs - in which you cannot select or copy any text - into fully text-
searchable PDF documents. 

The output formats are displayed in the Format group. 

 

The default formats are PDF, DOCX, ODT, EPUB and Audio. 

To change the default formats: 

 Click the down arrow in the Format group. 

 Drag the required format to one of the top positions in the Favorites list. 
The five top formats are displayed in the toolbar. 

 

Below you find an overview of the supported output formats. For each of these output formats, 
specific layout options are available. See the section Selecting the Layout Options for more 
information. 

PDF 

PDF stands for "Portable Document Format". It is a format developed by Adobe Systems Inc. to 
facilitate document exchange. PDF files are device-independent and resolution-independent, and 
can be opened on any Operating System (Windows, Mac OS, Linux, iOS, Android, etc.) PDF files are 
mostly used for storage purposes. Note that the content of PDF files cannot be edited (easily). 

With Readiris you can generate 4 types of PDF files: 
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 PDF Image-Text. This file type is most commonly used. It contains two layers: the recognized 
text, and the original image on top of the text. This way, you have both access to the 
recognized text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

 PDF Text-Image. This file type is the opposite of PDF Image-Text. It contains the original 
image in the background, and the recognized text on top of the image. 

Note: any recognition mistakes will be visible in this format. 

 PDF Text. This file type contains the recognized text, but does not contain the original image 
of your document. Any images in the original document are included as graphics in the PDF 
file. 

 PDF Image. When you select this file type, Readiris doesn't execute the text recognition on 
your document. Your PDF file will not be text-searchable, it only contains the image of your 
original document. 

Note: many options are available for PDF files. Readiris can generate hyper-compressed PDF files, 
password-protected PDF files, PDF/A-compliant PDF files. See the section PDF Options for more 
information. 

Tip: with Readiris you can also turn Image PDFs into text-searchable PDFs. 

DOCX 

DOCX is the standard text processor format used since Microsoft Word 2008. It is a standard format 
in several applications on the Microsoft Windows operating systems. 

DOCX is also supported by Pages for Mac and DOCX with simplified layout is supported in TextEdit. 

ODT 

ODT stands for "Open DocumentText". It is an open-source file format. 

ODT files can be opened with any OpenOffice-compatible text processor. 

RTF 

RTF stands for "Rich Text Formatting". It is a free document file format developed by Microsoft Inc. 
to facilitate document exchange. 

Use the RTF format when you do not have the possibility to use the DOCX or ODT formats. It is 
recommended to use Microsoft Word to open RTF documents generated by Readiris. 

XLSX 

XLSX is the standard spreadsheet file format used since Microsoft Excel 2008. XLSX files are created 
using the Open XML standard. Each cell in an XLSX file can have a different formatting. 

HTML 

HTML stands for "Hypertext Markup Language". It is the predominant markup language for web 
pages. It provides a means to describe the structure and formatting of text-based information in a 
document. This file format can be opened in Microsoft Excel, in Web browsers such as Safari, and in 
Web page editors such as Adobe Dreamweaver. 

Note: HTML is the recommended format when saving documents to Evernote. 
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TXT (Unicode text) 

A TXT file is a standard text document that contains unformatted text. TXT files can be opened in any 
text editing or word processing application. 

No Layout options are available for TXT files. 

EPUB 

EPUB is a free and open e-book standard by the International Digital Publishing Forum (IDPF). EPUB 
is designed for reflowable content, meaning that the presentation of the content automatically 
adapts itself to the device on which it is opened. EPUB also supports fixed-layout content.  

Note that Readiris only creates body text in EPUB files. Images are not included. 

Audio 

Audio .aiff is an audio file format standard for storing sound data. Save your documents in .aiff to 
have the text read out to you. See Audio Options for more information. 

Image File formats 

Although Readiris is a text recognition application, it can also save documents as image files. 

The following image file formats are supported as output: TIFF, PNG and JPEG. 

Selecting the Layout Options 

To access the Layout Options: 

 Click the down arrow in the Format group. 

 Select the Format of your choice. 

 Its options are displayed in the right-hand side of the windows. 
Below you'll find a short description of each options group. 
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Layout Options 

The Layout Options play an important role when generating Word processor documents (DOCX, 
ODT, RTF), Spreadsheet documents (XLSX) and Web page documents (HTML). They determine for a 
large part what your final documents will look like. 

Which layout options are available depends on the output format you select. When you select an 
image output format, such as PDF Image, or TIFF, for instance, these options are not available. 

See the sections Layout Options (Text Documents) and Layout Options (Spreadsheet Documents) 
for more information. 

Graphics Options 

The Graphics Options determine how the graphic zones will be presented in the output documents, 
e.g. in black-and-white or in color. They also define their resolution. 

Note: when you select an output format or application that does not support images, then the 
Graphics Options will be unavailable in Readiris. 

See the section Graphics Options for more information. 

Page Size 

The Page Size options allow you to define in which paper size (e.g. A4, Letter, Legal) your output 
documents will be generated. 

These options are available for DOCX, ODT, RTF and XLSX. 

See the section Page Size for more information. 

PDF Options 

When generating PDF documents, only the specific PDF Options are available. These include 
bookmarking, iHQC-compression and password protection. 

See the sections PDF Options and PDF Passwords for more information. 

Layout options (Text documents) 

The Layout Options play an important role when generating Word processor documents (.docx, .rtf, 
.odt), Spreadsheet documents (.xlsx) and Web page documents (.htm). They determine for a large 
part what your final documents will look like. 

Below you find a description of what each Layout option does and examples of real documents. The 
specific Layout options for Spreadsheet documents are discussed in the section Layout Options 
Spreadsheet Documents. 

Note: the Layout tab is of course unavailable when you select PDF or image files as output 
format. PDF is a fixed-layout format and by default re-creates the original layout of the 
document. 

Note: if any Layout option is unavailable for the output format you selected, this means the 
option in question is not supported. 

 The option Create body text generates a continuous, running line of text. The result is a 
document without any formatting. The formatting is to be done manually, by the user, in 
another application. 
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Example of body text 

 

 The option Retain word and paragraph formatting keeps the general format structure of 
your scanned document. 

The font type, size and type style are maintained across the recognition process. 

The tabs and the alignment of each block are recreated. 

The text blocks and columns aren't recreated; the paragraphs just follow each other. 

Tables are recaptured correctly. 

Example of word and paragraph formatting 

 

 The option Recreate source document tries to stay as close to the original layout as possible. 

The text blocks, tables and pictures are re-created in the same place as the original. 

The word and paragraph formatting are maintained. 

Hyperlinks are re-created too. 

Example of a re-created source document 

 

 The option Use columns instead of frames creates columns instead of text frames to 
position the information on the page. 



Readiris 15 - User Guide 

54 

Columnized texts are easier to edit than documents containing multiple frames: 
the text flows naturally from one column to the next. 

Note: should Readiris be unable to detect columns in the source document, then 
frames are still used as substitute solution. 

Tip: use this option when generating Word documents. 

 The option Insert column breaks inserts a hard column break at the end of each 
column, which maintains the format of the text. Any text you edit, add or remove, 
remains inside its column; no text flows automatically across a column break. 

Tip: disable this option (Insert column breaks) when you have body text that 
contains columns. You'll ensure the natural flow of the text from one column to 
the next. 

 The option Add image as page background places the scanned image as page 
background beneath the recognized text. 

Note: this option increases the file size of the output files substantially. 

The format PDF Text-Image modifies PDF files in the same manner. 

To avoid the file increase discussed above,  select the option Maintain colors of 
background. This provides a similar but less drastic, more compact alternative. 

 The option Merge lines into paragraphs enables automatic paragraph detection. 

Readiris wordwraps the recognized text until a new paragraph starts, and reglues 
hyphenated words at the end of a line. 

 The option Include graphics includes images in your output documents. 

Clear this option in case you only need lay-outed text. 

 The option Maintain colors of text keeps the original color of the text in your source 
documents. 

 The option Maintain colors of background recreates the background color of each 
document. 

Layout Options (Spreadsheet Documents) 

The following Layout Options are available when you select .XLSX as output format from the Format 
group. 

 

Worksheet: 

 The option Create one worksheet per page sees to it that one worksheet is created per 
scanned page. 

If a page contains tables and text, all is placed inside the same worksheet. 

 The option Create one worksheet per table places each table in a separate worksheet and 
includes the recognized text (outside the tables) in another worksheet. 

If the document being processed contains more than one page, each page will be 
processed in the same manner. 



Section 8: Selecting the Output Format 

55 

This option is useful when processing tables of different sizes and different headings. 

 The option Retain word style and text paragraphs keeps the general format structure of 
your scanned document. 

The font type, size and type style are maintained across the recognition process. 

The tabs and the alignment of each block are recreated. 

The text blocks and columns aren't recreated; the paragraphs just follow each other. 

Tables are recaptured correctly. 

Pictures are not captured. 

 The option Ignore all text outside the tables saves the tables and ignores all other 
recognition results. 

All data inside the tables is recaptured; any data outside the tables is not. 

Example image 

  

 The option Convert figures into numbers encodes recognized figures as numbers. 

As a result, you can execute arithmetical operations on those cells. The text cells (in 
any table) remain text. 

Note that only figures inside tables are encoded as numbers. 

 The option Merge lines into paragraphs enables automatic paragraph detection. 

Readiris wordwraps the recognized text until a new paragraph starts, and reglues 
hyphenated words at the end of a line. 

 The option Maintain colors of text keeps the original color of the text in your source 
documents. 

 The option Maintain colors of background recreates the background color of each 
document. 

Note: in a spreadsheet application, this option recreates the background color of each 
cell. 
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Selecting the Graphics options 

The Graphics Options determine how the images will be presented in the output documents, e.g. in 
black-and-white or in color. They also define their resolution. 

Note: when you select an output format or application that does not support images, then 
the Graphics Options will be unavailable in Readiris. 

Below you find a description of what each option does. 

 

Color type 

Readiris saves graphics in their original depth by default. 

Readiris can also save graphics in black-and-white, grayscale and color. 

Image quality 

You can choose between Low, Normal and High quality graphics. 

Resolution 

Readiris retains the original resolution by default. 

You can also choose to reduce the resolution to a lower dpi (between 50 and 300). 

Note that you cannot increase the resolution. 

Page Size 

In Readiris the page size of the documents you scan and open does not necessarily have to be the 
same as the page size of your output documents. 

When generating DOCX, XLSX, ODT or RTF documents, you can select the preferred page sizes: 
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 Select Use input images size to generate output documents that have the exact same size as 
the original files. 

 If you want to use a standard page size - in case you want to print your documents for 
instance - select Use first fitting size from standard size list. 

 Then select your preferred page sizes. 

 Now sort the selected page sizes in the order of your preference. 
Readiris tries to use the first page size in the list. If your document is too big for the page 
size, Readiris tries to second page size in the list, and so on. 
So make sure you drag your preferred page sizes to the top of the list. 

 When you are done, click OK to save and close the settings. 

Tip: to restore the default settings, click Default. 

PDF Options 

The documents you process with Readiris can be saved as PDF documents. 

To access the PDF options: 

 Click the down arrow in the Format group. 

 Select PDF in the Favorites list. 

 The PDF Options tab is displayed. 

 

PDF Type 

Select the PDF type from the Type list: 

 Text. This file type contains the recognized text, but does not contain the original image of 
your document. Any images in the original document are included as graphics in the PDF file. 

 Text-Image. This file type is the opposite of PDF Image-Text. It contains the original image in 
the background, and the recognized text on top of the image. 

Note: any recognition mistakes will be visible in this format. 
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 Image-Text. This file type is most commonly used. It contains two layers: the recognized 
text, and the original image on top of the text. This way, you have both access to the 
recognized text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

 Image. When you select this file type, Readiris doesn't execute the text recognition on your 
document. Your PDF file will not be text-searchable, it only contains the image of your 
original document. 

Version 

In this drop-down list you can select which PDF version you want to generate. 

PDF v 1.4: It takes Adobe Acrobat 5.0 and higher to open these documents. 

PDF v 1.7:  It takes Adobe Acrobat 8.0 and higher to open these documents. 

PDF / A-2: Generates PDF files that are suited for long-term archiving. PDF / A-2 is based on PDF v 
1.7. 

PFD / A-1: Generates PDF files that are suited for long-term archiving. PDF / A-1 is based on PDF v 
1.4. 

Note that PDF/A is not supported with Asian languages. 

Create bookmarks 

Bookmarks are types of links inside a PDF document, which contain representative information 
about the section they are linked to. Bookmarks give structure to your PDF documents. They are 
grouped in the Bookmarks panel in the Navigation pane. 

In Readiris, the option Create bookmarks creates a bookmark for each text zone, image zone and 
table zone inside a PDF file. 

Embed fonts 

The option Embed fonts, embeds - or includes - the original fonts of your documents in the PDF file. 
This way, other users will always see the documents in their original fonts on their computer, even if 
they don't have the particular font you used installed on their computer. 

Note that embedding fonts increases the file size of your output documents. 

Optimize for fast web view 

This option restructures a PDF document for page-per-page downloading from web servers. This 
option is useful when accessing the documents you sent to the Cloud.
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iHQC Compression 

In Readiris you also have the possibility to hyper-compress your PDF documents with iHQC. iHQC 
stands for intelligent High-Quality Compression, I.R.I.S.' proprietary, efficient compression 
technology. iHQC is to images what MP3 is to music and what DivX is to movies. 

iHQC is available for Image-Text and Image PDFs. 

Select the compression type: 

 Good quality - best compatibility: no use of wavelet compression (JPEG2000) and no use of 
symbols compression (JBIG2). 

 Good compression - best compatibility: does the same as the previous option but with 
more aggressive compression factors for the background and foreground images. 

 Better compression - good compatibility: use of symbols compression (JBIG2) but no use of 
wavelet compression (JPEG2000). 

 Better compression - good quality: use of symbols compression and wavelet compression 
with moderately aggressive compressions factors 

 Best compression: use of symbols compression and wavelet compression with more 
aggressive compression factors. 

 Custom (Readiris Corporate only): use of symbols compression, wavelet compression and 
compression factors are set freely. 

 

PDF Passwords 

(This section applies to Readiris Corporate only) 

The PDF documents you generate with Readiris can be password-protected. You can set a password 
to open the documents, and a password that restricts modifications to the documents. 

To access the PDF Password options: 

 Click the down arrow in the Format group. 

 Select PDF in the Favorites list. 

 Then click the PDF Passwords tab. 

 When you set an open document password, you will be prompted to enter that password 
when opening the PDF output. 

 When you set a permissions password, you will only be able to perform the actions 
specified in the security settings. If you do want to change these settings, you must enter the 
permissions password. 

The Readiris security settings are similar to the standard protection features offered by 
Adobe Acrobat. 

Note that in Readiris the open document password and permissions password must 
be different. 
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EPUB Options 

EPUB is a free and open e-book standard by the International Digital Publishing Forum (IDPF). EPUB 
is designed for reflowable content, meaning that the presentation of the content automatically 
adapts itself to the device on which it is opened. EPUB also supports fixed-layout content. 

Note that Readiris only creates body text in EPUB files. Images are not included. 

The option Merge lines into paragraphs is selected by default. Readiris wordwraps the recognized 
text until a new paragraph starts, and reglues hyphenated words at the end of a line. 

 

Audio Options 

Audio .aiff is an audio file format standard for storing sound data. Save your documents in .aiff to 
have the text read out to you. 

To access the Audio Options: 

 Click the down arrow in the Format group. 

 Click Audio in the Favorites list. 

 Click the Voice list and select which voice should read out the text. 

Voices marked with (*) must be downloaded before use. 

 Move the Speaking rate slider to adjust the speed. 
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Section 9: Saving Documents 

The documents you process in Readiris can be saved to different destinations: 

 You can save them locally as file. 

In this case the documents are simply stored on your computer and you can export and 
share them later. 

The pages that are opened in Readiris are saved into a single output file, except when you 
select an image file as output format. In that case Readiris saves them as separate image 
files. 

 You can open them in an application. 

This is useful when text editing needs to be done. Once that's done you can save the 
documents. 

Note that the TextEdit application does not support complex layouts. 

 You can export them to an online Storage System. 

Readiris exports documents to Evernote, Dropbox, Google Drive, Microsoft OneDrive and 
Box. Readiris Corporate also exports documents to Microsoft SharePoint. 

  

To select a destination: 

 Click the down arrow in the Destination group. 

 Select Save locally or select an online Storage application. 

Note that only the online Storage Applications you have already configured are 
displayed in the list. To configure a new application, click the plus sign at the bottom of 
the screen. See Saving Documents to online Storage Systems for more information. 

 Select the required Output Format from the list. 

The formatting options you configured in the Format group are applied to the format 
you select here. See Selecting the Output Format if necessary. 

 When you select Save locally, you can choose to simply generate the File or open your 
document in an Application. 

When you select Open in application, a default application that supports the selected 
output format is proposed. To select a different application, click the application list 
and then click Select Application. Browse for a compatible application and click Open. 
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 When you select an online Storage application, specify the location where you want to store 
your documents. 

 

 Now close the settings and process your documents in Readiris to send them to the 
configured destination. 

Appending PDF documents 

In Readiris 15 you can not only generate new PDF documents, but also add pages to existing PDF 
documents. 

 Select PDF in the Format group. 

 Select PDF+ in the Destination list. 

 

 Process your document and click Save. 

 In the window that opens select the PDF  file to which you want to add your document. 

Starting a new project 

 Click New on the top toolbar. 
This command erases your document from Readiris so you can start a new one. 

 

Saving Documents to online Storage Systems 

Readiris exports documents to Evernote, Dropbox, Google Drive, Microsoft OneDrive and Box. 
Readiris Corporate also exports documents to Microsoft SharePoint. 

Before you can export to these systems, a few requirements need to be met: 

 You need a valid account for each application. 

 Internet access is required. 

 The connection must be configured. 
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To configure a connection: 

 Click the down arrow in the Destination group. 

 Click the plus sign at the bottom of the window. 

 Select an account from the Account type list. 

Note: this can also be done via Readiris > Preferences > Accounts. 

 

Google Drive 

 Enter your Email and Password, then click Sign in. 

 Select the option that allows Readiris to access your account. 

 Select the folder to which you want to export documents, and then click Finish. 

Note that you can add multiple Google Drive accounts. 

Evernote 

Preliminary note: the Evernote application must be installed on your computer and must be 
connected to your Evernote account. 

 Click Select to specify to which Notebook you want to export documents. 

Microsoft OneDrive 

 Enter your Microsoft account and Password, then click Sign in. 

 Select the option that allows Readiris to access your account. 

 Select the folder to which you want to export documents, and then click Finish. 

Note that you can add multiple Microsoft OneDrive accounts. 

Box 

 Enter your Email address and Password, then click Authorize. 

Note: you can also use Single Sign On (SSO). 

 Select the option that allows Readiris to access your account. 



Readiris 15 - User Guide 

64 

 Select the folder to which you want to export documents, and then click Finish. 

Dropbox 

Preliminary note: the Dropbox application must be installed on your computer and must be 
configured for your Dropbox account. 

 Click Select to specify to which Storage Folder you want to export documents. 

When you are done, close the Preferences window. 

Microsoft SharePoint 

 Enter your Username and Password. 

 Enter the server to connect to. 

 Then click Browse. 

 Select the required folder to export to. 

 If necessary, select Content Type. 

Note: if you keep the following option selected "Ask for confirmation before 
exporting" you will always need to indicate the export folder when processing 
documents. To avoid this step, clear this option. 

Removing an online Storage System 

To remove an online Storage System from the Readiris configuration: 

 Click the down arrow in the Destination group. 

 Select the account you want to remove. 

 Then click the minus sign at the bottom. 

Saving Documents as Audio File 

Readiris can now convert documents into Audio files that can be read out to you. 

To access the Audio Options: 

 Click the down arrow in the Format group. 

 Click Audio in the Favorites list. 

 Click the Voice list and select which voice should read out the text. 

Voices marked with (*) must be downloaded before use. 

 Move the Speaking rate slider to adjust the speed. 

To save a document as Audio File: 

 Click the down arrow in the Destination list. 

 Click Save locally. 

 Select Audio as Output format. 

 Select Open in application and click OK. 

 Now process your documents in Readiris. The document will be read out to you by the 
application you selected. 
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Saving the Contents of Particular Zones 

Besides saving entire documents, you can also save the contents of particular zones: 

 Ctrl-click the zone you want to recognize. 

 Then click Copy as ... 

 The results are copied to the clipboard. You can now paste them into other applications. 

Note that you can also send content directly to Evernote, if the connection is configured correctly. 

 

Saving Images 

Although Readiris is a text recognition application, it can also save documents as image files.  

To save documents as images: 

 Click the down arrow in the Destination group. 

 Select Save locally. 

 Select Image as Output Format. 

Images can be saved as TIFF, PNG or JPEG, depending on the format your configured in 
the Format settings. 

Other ways of saving documents as image files 

 Ctrl-click a Graphic zone in your documents, and select Copy as Graphic. 
This command copies the image to the Clipboard.  

 The image can now be pasted into another application. 

 

 Or drag a thumbnail from the Pages panel or Thumbnail view to the Desktop to save the 
entire page as JPEG image. 
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Section 10: Processing Batches of Documents 

Batch Processing 

(This section applies to Readiris Corporate only) 

When you are processing entire batches of image files you can use Readiris' Batch Processing folder. 
Batch Processing executes the recognition on all scanned images in a specific folder. Indicate to 
Readiris in which folder your documents are located, start the processing and all your documents 
will be converted to the required output format. 

To start batch processing: 

 On the Process menu, click Batch Processing. 

 

 

 Select an Image input folder. 

This is the folder to which you scan the documents. 

 Select an Output format. 

The configurations you applied in the Format group are available here. See the topic 
Selecting the Output Format for more information. 

 Select an Output folder or account. 

This is the folder or account where your processed documents will be stored. 

The configurations you applied in the Destination group are available here. See the topic 
Saving Documents for more information. 

Important note: do not select an output folder that is also being used as Watched Folder. 

Batch Processing Options 

 In case you want to process the underlying subfolders of the Input folder, select Process 
subfolders. 

 If you want Readiris to overwrite existing output files in the Text output folder, select 
Overwrite text files. 
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 If you want Readiris to delete the original images from the Input after processing, select 
Delete images after processing. 

When you are done selecting the options, click OK for Readiris to start Batch processing the folder. 

Readiris processes the images of all supported file formats. You cannot limit the recognition 
to files of a specific file format. 

The recognized documents get the same file name as the original image files. 

A log file is created per batch, containing the processing date and the document names and 
paths. 

Watched Folder 

(This section applies to Readiris Corporate only) 

If you need to scan entire batches of documents, on a scanner equipped with a document feeder, for 
instance, you can use Readiris' Watched Folder feature. This way, you can scan all your documents 
to a specific folder that is being monitored by Readiris. Whenever Readiris spots a new document 
inside the Watched Folder, it processes it and sends it to an output folder. 

To set up a Watched Folder: 

 On the Process menu, click Watched Folder. 

 

 

 Select an Image input folder. 

This is the folder to which you scan the documents. 

 Select an Output format. 

The configurations you apply in the Format group are available here. Tip: see the topic 
Selecting the Output Format for more information. 

 Select an Output folder or account. 

This is the folder or account where your processed documents will be stored. 

The configurations you applied in the Destination group are available here. See the topic 
Saving Documents for more information. 

Important note: do not select an output folder that is also being used as Watched Folder. 
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Watched Folder Options 

 In case you want to process the underlying subfolders of the Watched Folder, select Process 
subfolders. 

 If you want Readiris to overwrite existing output files in the Text output folder, select 
Overwrite text files. 

 If you want Readiris to delete the original images from the Watched Folder after processing, 
select Delete images after processing. 

When you are done selecting the options, click OK for Readiris to start monitoring the Watched 
Folder. 

Readiris will process any images it spots inside the folder. 

 

The monitoring continues even if you quit Readiris. 

To add documents to the Watched Folder while it is being monitored by Readiris: 

 Scan documents to the Watched Folder, or 

 Move existing image files to the Watched Folder. 
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How to 

How to configure your scanner in Readiris 

Readiris supports all Twain 1.9 compliant scanners, all Image Capture compliant scanners, and 
IRIScan 2 and higher scanners. 

Most Image Capture scanners are plug and play. Before you can use a Twain scanner, however, its 
drivers need to be installed on your Mac. 

Twain scanners 

 Connect your scanner to your Mac and power it on. 

 Install your scanner's Twain driver. 

In general, drivers can be found on the CD-ROM provided with your scanner and on the 
website of your scanner manufacturer. They are not provided by I.R.I.S. Note that some 
scanner drivers may not work under the latest versions of Mac OS. See the 
documentation supplied with your scanner to find out which platforms are supported. 
If necessary, contact your scanner manufacturer. 

IRIScan scanners 

 Connect your *IRIScan scanner to your Mac and power it on. 

 Install your scanner's Twain driver. 

*Note that you do not need to install any drivers when using an IRISCard Anywhere, 
IRIScan Anywhere or IRIScan Book scanner. They are not Twain driver-based scanners 
that can be used from within any application to scan documents. Instead, they are 
designed to be used on their own, disconnected from any computer. The documents 
you scan are stored in the scanner’s internal memory (or optional SD card / USB flash 
drive). From there they can be loaded directly into Readiris when you connect the 
scanner or insert the SD card or USB flash drive into your Mac. 

To check if the scanner driver has been installed successfully: 

 In the Readiris menu, click Preferences. 

 Click the Scanner tab. 

 You should see your scanner listed. 

 

If your scanner is not listed, its driver has not been installed successfully. 

Note that the IRIScan settings at the bottom are only available if an IRIScan Express 2 scanner 
is connected. 
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 Once the scanner has been configured you can start scanning, using the default scanner 
settings. 

How to recognize barcodes 

Readiris supports most widespread 2D barcodes, both laser printed and inkjet printed. 

In Readiris Corporate, barcodes can also be used to separate documents in a batch. Note that in this 
case the content of the barcodes is not converted into text, the barcodes are only used to do the 
separation. 

  

 

Recognizing barcodes manually 

 Scan or Open your document. 

 Click the Layout icon in the Image and Layout Editing toolbar. 

 

 Then click the Barcode icon in the menu that appears, and draw a frame around the barcode 
zone. 

 Close the Layout tool and process your document. The content of the barcode will be 
processed as well. 

Recognizing a particular barcode 

In case you need to use the content of a particular barcode: 

 Repeat the previous steps to draw a barcode zone. 

 Ctrl-click the barcode zone and select Copy as data. 

The recognized content of the barcode is copied to the Clipboard. From there you can paste it 
into other applications. 

Note that need to close the Layout tool in order to Ctrl-click a zone. 
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Recognizing barcodes to separate document batches 

(This section applies to Readiris Corporate only) 

Barcodes can be used as separators to separate documents in a document batch. Readiris can 
automatically look for barcode pages and mark them as cover page, indicating the beginning of a 
new document. 

 On the Settings menu click Document Separation and Indexing. 

 Select Detect cover pages with a barcode. 

If necessary, indicate specific content Readiris should look for. For more information 
see the section How to separate document batches. 

Note: the barcode reading results can also be included in an XML index. Select the 
option Generate an XML index and check the box Include text of cover pages in index. 

 Click OK to save the settings. Then process your documents. 

How to improve the recognition results 

The quality of the recognition results depends on a number of factors: 

 The document language 

Make sure you select the right language in the Language list. See the section Recognition 
Options for more information. 

 The quality of the scanned documents 

If the scanned documents are too bright, or too dark, Readiris will have trouble recognizing 
them. Luckily there is a feature that allows you to adjust the quality of scanned documents. 
See the section Adjusting the Image Quality to learn how to do so. 

 The scanner settings 

If you are using a scanner to scan documents, the image quality is also linked to the scanner 
settings. See the section Scanning Documents and General Processing Options to make sure 
the right settings have been selected for your scanner. 

Make sure the scan resolution is set to 300 dpi for regular documents and to 400 dpi for 
small print and Asian languages.
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How to process digital camera images 

Readiris automatically detects when images have been made by a digital camera and uses special 
recognition algorithms to process them. 

To open digital camera images: 

 Click File on the top toolbar. 

 

 Select your digital camera images and click Open. 

 In the page thumbnail, you see a little camera icon, which indicates Readiris recognizes the 
image as digital camera image. 

 

If Readiris does not detect your image is a digital camera image: 

 Ctrl-click the page thumbnail. 

 Select Digital Camera Image. 
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Deskewing Digital Camera Images 

When photographing documents with a digital camera, it may happen that the documents are shot 
from an angle, which gives them a 3D effect and renders the recognition impossible. 

To solve this issue, you can deskew your digital camera images: 

 Open your digital camera image. 

 On the Layout and Editing toolbar, click the Deskew icon. 

 

 Drag the corners one by one in the direction of your text. 

 

 Click Apply to deskew the image. 

Tips for making digital camera images 

 Always select the highest image resolution. 

 Enable the macro mode of the camera to take close-ups. 

 Enable the document mode of the camera (if any) 

 Only use optical zoom, not digital zoom. 

 Hold the camera directly above the document. Avoid photographing documents at an angle. 

 Produce stable images. 

 Disable the flash when photographing glossy paper. 

 Avoid opening compressed camera images.
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How to separate document batches 

(This section applies to Readiris Corporate only) 

When you are scanning entire stacks of paper - on a scanner equipped with a document feeder for 
instance - it can be useful to indicate where one document ends and another begins. That way, 
Readiris can generate a separate output file for each document. This avoids your having to scan only 
one document at a time. 

Example 

Let's say you're scanning a stack of 30 pages. The first 10 pages belong to Document 1, pages 11 to 
20 belong to Document 2 and pages 21 to 30 belong to Document 3. If you indicate that your stack 
of paper in fact contains 3 documents, Readiris will generate 3 separate output files. 

  

How to separate paper documents 

With Readiris, there are 2 ways to separate paper documents. You can do this by means of: 

 blank pages 

In this case you simply put a blank page between two sheets of paper to indicate where the 
new document begins. Note that you can delete all blank pages simultaneously after 
recognition should this be necessary: click the command Delete Blank Pages on the Process 
menu to do so. 

 cover pages containing a barcode 

In this case you can, for instance, put a barcode sticker on each first page of a document. 

  

To access the document separation options: 

 Click the Settings menu and click Document Separation and Indexing. 

 Indicate which separation method you are going to use: Detect blank pages or Detect cover 
pages with a barcode. 

When you are using barcode pages as cover page, you can indicate specific data your 
barcodes should contain in order for Readiris to consider them to be barcode pages. Insert 
your company name for instance, I.R.I.S. in our case, in the field containing. Only barcodes 
that contain the data 'I.R.I.S.' will be marked as cover pages and will be used to split up your 
document batch into separate documents. You can also add a variable part to the data, for 
instance the scanning date. This variable part will indicate the specific indexing data of each 
individual document. 
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 In case you want Readiris to generate an XML index file containing detailed information on 
the processed documents, select the option Generate an XML index. 

An XML index file will be created per document. The index file contains detailed information 
such as the detected barcode separator, the page range, the output file name and the cover 
page text (if selected). 

To include the text of the cover pages in the XML index, select the corresponding option. 
Note that these reading results are not included in the output document. 

 If your cover pages also contain content you want to include in the processed output 
documents, select Recognize cover pages. 

 Then click OK to save the settings and start processing document batches. 

The document batch will be split up and can be saved in separate output documents. 

  

Separating opened documents manually 

 Click the Open button on the main toolbar and select the documents you want to open. 

 Use the Batch Processing or Watched folder function when scanning large volumes of 
documents. 

The Pages panel will display the page thumbnails. 

 Ctrl-click the pages you want to mark as cover pages, and click Cover page. 
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The page thumbnail in the Pages panel now displays the cover page icon. 

 

Note: in Thumbnail view, each cover page is put on a different line, to facilitate the overview. 

 

 Click the Save button to process the documents. 

How to separate batches of image files 

(This section applies to Readiris Corporate only) 

When you are processing batches of image files and don't want Readiris to convert them into a 
single output file, you can use cover pages to separate them. 

To do so: 

 Import all the images you want to process. 

 In the Pages panel, indicate at which page you want Readiris to start a new document: 

 Select the page. 

 Then Ctrl-click it and click Cover page. 
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 The page icon turns into a Cover page icon. 

 

Note: if you want the cover pages to be included in the output documents, select the corresponding 
Document Separation options: 

 On the Settings menu, click Document Separation and Indexing. 

 Then select Recognize cover pages. 
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How to recognize forms 

Note that Readiris is not designed to recognize complex forms. Readiris recognizes documents by 
converting pictures of text characters and numbers into actual text and numbers. Forms, on the 
other hand, contain many graphic elements such as lines, boxes, check boxes and the like, which 
complicate Readiris' tasks. 

Use the following rule of thumb if you try to recognize forms: if you would be able to re-create the 
form fairly easily from scratch inside Microsoft Word or Pages for Mac, Readiris has a good chance of 
processing it. If it would take an extraordinary effort to re-create it in Word, then Readiris will have 
the same difficulty. 

Example 

Form Readiris would not be able to process correctly 

 

How to process low-resolution images 

A resolution of 300 to 400 dpi is required to obtain optimal results in Readiris. When you try to scan 
or open images of a resolution lower than 200 dpi or higher than 600 dpi, Readiris will display a 
warning. 

When you are faced with these kind of images, the best thing you can do is re-can the images in an 
appropriate resolution. If that's not possible, there are few tips and tricks that help you obtain better 
results: 

Tip 1 

When scanning images of an unknown resolution or images of which the file header displays an 
incorrect resolution, make sure to select the option Process as 300 dpi: 

 On the Readiris menu, click Preferences. 

 Click the General tab. 

 Select the option Process as 300 dpi. 

When this option is selected, Readiris treats the images as if they had a 300 dpi resolution. 
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Tip 2 (Readiris Corporate  only) 

Make sure that favor OCR accuracy over speed when processing low-quality documents: 

 Click the Settings menu. 

 Click Advanced Text Recognition Options. 

 Make sure the option Favor accuracy over speed is selected. 

Note: 

When you are processing low-resolution faxes, there is no need to take special measures. Readiris 
detects the typical fax resolutions 100 x 200 dpi (normal quality), 200 x 200 dpi (fine quality) and 200 
x 400 dpi (superfine quality) and preprocesses these images automatically to ensure optimal results. 
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